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Software License Agreement
This Software License Agreement (“License Agreement”) is a legal agreement between you (either an
individual or a single entity) and Serif, Inc. (“Serif”) for the accompanying software product, which
includes computer software and may include associated media, printed materials, and “online” or electronic
documentation (the “Software Product”). By installing, copying, or otherwise using the Software Product,
you agree to be bound by the terms of this License Agreement. If you do not agree to the terms and
conditions of this License Agreement, do not install or use the Software Product; you may, however, return
it to your place of purchase for a full refund.
THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS IMPORTANT THAT YOU (THE “LICENSEE”) READ
THIS NOTICE CAREFULLY. THESE ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTS WITH RESPECT
TO THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT IS PROTECTED BY COPYRIGHT LAWS AND INTERNATIONAL
COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL PROPERTY LAWS AND TREATIES. THE SOFTWARE PRODUCT
IS LICENSED, NOT SOLD.

1. GRANT OF LICENSE
Serif hereby grants to Licensee a personal, non-exclusive, non-
transferable license (a “License”) to use one (1) copy of the Software
Product, including any updates thereto, and accompanying
documentation, if any, provided by Serif, according to the terms set
forth below. If the Software Product is being provided to Licensee as
an update or upgrade to software which Licensee has previously
licensed (such software referred to as the “Prior Software”), then
Licensee agrees to destroy all copies of the Prior Software within
thirty (30) days after opening this package except for one backup
copy of the Prior Software.

2. SCOPE OF USE
You may install and use one copy of the Software Product, on a
single computer. The primary user of the computer on which the
Software Product is installed may make a second copy for his or her
exclusive use on a portable computer. Licensee may also store or
install a copy of the Software Product on a storage device, such as a
network server, used only to install or run the Software Product on
other computers over an internal network; however, you must
acquire and dedicate a license for each separate computer on which
the Software Product is installed or run from the storage device. A
license for the Software Product may not be shared or used
concurrently on different computers.

3. LICENSE PAK
If you have acquired this LICENSE AGREEMENT in a Serif
License Pak, you may make the number of additional copies of the
computer software portion of the Software Product as authorized in
the Serif License Pak, and you may use each copy in the manner
specified above. You are also entitled to make a corresponding
number of secondary copies for portable computer use as specified
above.

4. PROHIBITIONS
You may not: modify, prepare derivative works from, translate,
reverse engineer, decompile, disassemble or otherwise derive source
code from the Software Product (except to the extent that such acts
are expressly permitted by applicable law notwithstanding this
limitation); copy the Software Product (except as provided above) or
the accompanying documentation; rent, transfer, disclose, make
available or grant any rights in the Software Product (including any
accompanying documentation) in any form to any person without the
prior written consent of Serif; remove any proprietary notices, labels,
or marks on the Software Product (including any accompanying
documentation); use the Software Product in any manner that
infringes the intellectual property or other rights of another party; or
use the Software Product to provide on-line or other database
services to any other person.

5. RETENTION OF RIGHTS; TERMINATION
This License Agreement does not constitute a sale. All title, trade
secrets, copyrights, patents and other intellectual rights to the
Software Product, its accompanying documentation and any copy

made by Licensee remain with Serif, and Licensee hereby agrees to
preserve and acknowledges the foregoing. Licensee further agrees
and acknowledges that the Software Product and all copies thereof
are Serif’s exclusive property and constitute a valuable trade secret
of Serif. Licensee further agrees and acknowledges that unauthorized
copying of the Software Product or the accompanying
documentation, or failure to comply with any of the provisions
hereof (each, a “Terminable Event”), will result in automatic
termination of this License. In the event of a violation of this License
by Licensee, Serif reserves and shall have available all legal
remedies.

6. TERM OF LICENSE FOR TRIAL VERSION SOFTWARE
The License pertaining to a trial version of the Software Product (a
“Trial Version”) shall expire in accordance with the terms as set
forth in the installation process for the Trial Version along with the
designated trial period as set forth in the trial program.

7. LIMITED WARRANTY AND DISCLAIMER
Serif warrants that, for a period of ninety (90) days after delivery, the
diskettes or CD-ROMs on which the software included in the
Software Product is furnished will, under normal use, be free from
defects that prevent Licensee from loading the Software Product on a
computer. Serif’s entire liability and Licensee’s exclusive remedy
under this warranty will be, at Serif’s option, to (a) use reasonable
commercial efforts to attempt to correct or work around errors, or (b)
to replace the Software Product with functionally equivalent
Software Product, on diskettes or CD-ROM, as applicable or (c)
return the price paid for the Software Product, in each case upon
return of the Software Product to Serif together with a copy of your
receipt for the purchase thereof. This Limited Warranty is void if
failure of the Software Product or hardware has resulted from
accident, abuse, or misapplication. Any replacement Software
Product will be warranted for the remainder of the original warranty
period or thirty (30) days, whichever is longer. Outside the United
States, neither these remedies nor any product support services
offered by Serif are available without proof of purchase from an
authorized non-U.S. source. The Software Product is licensed to you
on an “as is” basis without any warranty of any nature.

8. NO OTHER WARRANTIES
Except for the above express limited warranties, Serif and its
suppliers make and licensee receives no warranties or conditions, or
terms, express, implied, statutory, or in any communication with
licensee. To the maximum extent permitted by applicable law, Serif
and its suppliers disclaim all other warranties and conditions, either
express or implied, including, but not limited to, implied warranties
of merchantability, fitness for a particular purpose, title and non-
infringement, with regard to the software product and the provision
of or failure to provide support services. Licensee shall be solely
responsible for the selection, use, efficiency and suitability of the
software product and serif shall have no liability therefor. Serif shall
have no liability for, nor obligation to indemnify licensee regarding
actions alleging the infringement of proprietary rights by the
software product. Serif does not warrant that the operation of the
software product will be uninterrupted or error free or that the



software product will meet licensee’s specific requirements. The
Limited Warranty gives you specific legal rights. You may have
others, which vary from state/jurisdiction to state/jurisdiction.

9. LIMITATION OF LIABILITY
In no event will Serif or its suppliers be liable for loss of data,
corruption, lost profits, cost of cover, or other special, incidental,
punitive, consequential, or indirect damages arising from the use of
the software product (including any accompanying documentation),
however caused and on any theory of liability. This limitation will
apply even if Serif or an authorized distributor has been advised of
the possibility of such damage. In no event will Serif’s liability
exceed the amount paid for the software product. Licensee
acknowledges that the amounts paid by licensee for the software
product reflect this allocation of risk. Some states or other
jurisdictions do not allow the exclusion or limitation of liability for
incidental or consequential damages, so the above limitations and
exclusions may not be applicable in certain instances. None of the
above affects the statutory rights of licensees residing in the United
Kingdom.

10. NOT FOR RESALE SOFTWARE

If the Software Product is labeled “Not for Resale” or “NFR,” then,
notwithstanding section 1 of this License, your use of the Software
Product is limited to use for demonstration, test, or evaluation
purposes.

11. NO RENTAL; OTHER TRANSFERS
You may transfer this License to another computer or workstation
only on a permanent basis (that is, with no intent to transfer again)
provided the computer, workstation, or other digital electronic
device from which you have transferred this License no longer
accesses or otherwise utilizes the Software Product, and the Software
Product is used in accordance with the terms of this License
Agreement.

12. TERMINATION
You may terminate this License Agreement at any time. Serif may
terminate this License Agreement if you fail to comply with the
terms and conditions of this License Agreement. In either event, you
must destroy all copies of the Software Product.

13. UPGRADE
If this License is an “Upgrade,” you must have a valid license for the
Prior Software for this License Agreement to be valid, and this
License Agreement must be used to replace such license for the Prior
Software. The total number of license “Upgrades” you may acquire
may not exceed the total number of computers, workstations, or
other digital electronic devices that were licensed to access or
otherwise utilize the Software Product at the time you upgraded the
Software Product.

14. GUIDELINES FOR THE USE OF DIGITAL CONTENT
IMAGES

This product contains numerous clipart and photo images
(collectively referred to as the “Images”) which are either owned by
Serif or licensed from a third party. As a user of this product you are
free to use, modify, and publish the Images as you wish subject to
the restrictions set out below. If you are uncertain as to whether your
intended use complies with the guidelines set out below, we
recommend that you seek the advice of your own attorney or legal
counsel.

A. YOU MAY, subject to any restrictions set out below:

1. Incorporate any Image(s) into your own original work and
publish, display, and distribute your work in any media. You may

not, however, resell, sublicense, or otherwise make available the
Image(s) for use or distribution separately or detached from a

product or Web page. For example, the Image(s) may be used as part
of a Web page design, but may not be made available for
downloading separately or in a format designed or intended for
permanent storage or reuse by others. Similarly, clients may be
provided with copies of the Image(s) (including digital files) as an
integral part of a work product, but may not be provided with the
Image(s) or permitted to use the Image(s) separately or as part of any
other product;

2. Make one (1) copy of the Image(s) for backup or archival
purposes.

B. YOU MAY NOT:

1. Create scandalous, obscene, defamatory, or immoral works using
the Image(s) nor use the Image(s) for any other purpose prohibited
by law;

2. Use or permit the use of the Image(s) or any part thereof as a
trademark or service mark, or claim any proprietary rights of any
sort in the Image(s) or any part thereof;

3. Use the Image(s) in electronic format, on-line, or in multimedia
applications unless (a) the Image(s) are incorporated for viewing
purposes only and (b) no permission is given to download and/or
save the Image(s) for any reason;

4. Rent, lease, sublicense, or lend the Image(s), or a copy thereof, to
another person or legal entity. You may, however, transfer all your
license to use the Image(s) to another person or legal entity, provided
that (a) you transfer the Image(s) and this License, including all
copies (except copies incorporated into your work product as
permitted under this License), to such person or entity, (b) that you
retain no copies, including copies stored on a computer or other
storage device, and (c) the receiving party agrees to be bound by the
terms and conditions of this License;

5. Use any Image(s) except as expressly permitted by this License.

15. MISCELLANEOUS
This Agreement shall not be governed by the 1980 U. N. Convention
on Contracts for the International Sale of Goods; rather, this
Agreement shall be governed by the laws of the State of New Jersey,
of the United States of America, including the Uniform Commercial
Code of the State of New Jersey, without reference to conflicts of
law principles. This Agreement is the entire Agreement between
Serif and Licensee and supersedes any other communications or
advertising with respect to the Software Product. If any provision of
this Agreement is held invalid or unenforceable, such provision shall
be revised to the extent necessary to cure the invalidity or non-
enforceability, and the remainder of this Agreement shall continue in
full force and effect. If the Software Product is acquired by the
United States Government or on its behalf, the Software is furnished
with restricted rights. The use, duplication, or disclosure by the
United States Government and parties acting on its behalf is
governed by, and subject to restrictions as set forth in subdivision (c)
(1) (ii) of the Rights in Technical Data and Computer Software
clause at DFARS 252.227-7013, the subparagraphs (c)(1) and (2) of
the Commercial Computer Software - Restricted Rights at 48 CFR
52.227-19, or other comparable regulations of other government
agencies, as applicable. Licensee agrees not to allow the Software
Product to be sent to or used in any other country except in
compliance with applicable United States laws and regulations. This
Agreement shall constitute the entire agreement between Serif and
Licensee and supersedes all prior agreements, understandings,
communications, proposals or representations, oral or written, by
either party. This Agreement shall be amended only by an executed
writing by authorized representatives of both parties.



How to contact us

Our main office (USA, Canada):
The Software Center
PO Box 803, Nashua NH 03061 USA

Main (603) 889-8650
Registration (800) 794-6876
Single Unit Sales (800) 55-SERIF or 557-3743
Technical Support (603) 886-6642
Customer Service (800) 489-6720
General Fax (603) 889-1127

Technical Support E-mail support@serif.com

European office (UK, Europe):
The Software Centre
PO Box 2000, Nottingham, NG11 7GW, UK

Main (0115) 914 2000
Registration (0500) 454 645
Sales (0800) 376 4848
Technical Support (0115) 914 9090
Customer Service (0115) 914 9090
General Fax (0115) 914 2020

Technical Support E-mail support@serif.co.uk

Online
Visit us on the Web at http://www.serif.com

International
Please contact your local distributor/dealer. For further details please contact
us at one of our phone numbers above.

Comments or other feedback
We want to hear from you! E-Mail feedback@serif.com with your ideas and
comments!

http://www.serif.com


Contents
1 ♦ Welcome

Welcome .................................................................................................. 3
About the Companion .............................................................................. 3
What’s New in 3DPlus 3.0........................................................................ 4
...Plus These Established Features ......................................................... 5

2 ♦ Getting Started

Registration, Upgrades, and Support....................................................... 9
Installation................................................................................................ 9

What you need to run 3DPlus .......................................................... 9
What you need to know.................................................................. 10
First-time install .............................................................................. 10
3DPlus 3.0 Resource CD-ROM...................................................... 10
Manual install/re-install................................................................... 10

Starting 3DPlus ...................................................................................... 11
Instant Designs and Animations…......................................................... 12

Note: Choosing a driver setting ...................................................... 13

3 ♦ Working with 3D Scenes

It’s a 3D World... .................................................................................... 17
Guided Tour: 3D Scenes........................................................................ 19

Making a scene .............................................................................. 19
The object of the exercise .............................................................. 20
The right tool for the job ................................................................. 20
Different viewpoints ........................................................................ 24
Some local color............................................................................. 26
Shedding light on the situation ....................................................... 27
The plane truth ............................................................................... 30

4 ♦ Creating New 3D Objects

Welcome to the Workshop ..................................................................... 35
Guided Tour: The 3D Workshop ............................................................ 35

From 2D to 3D................................................................................ 36
Turn, turn, turn................................................................................ 38
Drawing shapes.............................................................................. 40
Text and more ................................................................................ 42



5 ♦ Working with 3D Text & Animation

Editing 3D Text ...................................................................................... 47
Animation Basics ................................................................................... 49
Guided Tour: 3D Animation.................................................................... 50

Around the world in 20 frames ....................................................... 50
Editing Animations ................................................................................. 53

6 ♦ Using 3DPlus with Other Software

Exporting................................................................................................ 57
Export settings................................................................................ 57
The .PNG Format ........................................................................... 59
Animation formats .......................................................................... 60

OLE (Object Linking and Embedding).................................................... 60



Welcome

1



Welcome    3

Welcome
Ready to add a new dimension to your Web graphics projects, presentations,
or desktop publishing? 3DPlus 3.0 will take you there! And no special skills
are required—whether you use Wizards to create instant 3D elements and
animations for you, or construct your own 3D scenes. 3DPlus puts all the
tools and resources you’ll need within easy reach. To create, you just pick
and choose, mix and match—customize to your heart’s content. The
professional-quality results will amaze you!

About the Companion
This Companion is your guide to getting started and getting results with
3DPlus—from initial installation through advanced tips and examples.

� Welcome. Read on for a feature summary—a checklist of the fun
that’s in store for you.

� Installation and Startup. How to get up and running, and create
instant 3D designs and animations.

� Working with 3D Scenes. First, some 3D basics. Then, give us
fifteen minutes... we’ll put all our tools at your command.

� Creating New 3D Objects. A comprehensive look around the new
3D Workshop, where you’ll be building your own sophisticated
models in no time at all.

� Working with 3D Text and Animation. How to edit 3D words and
characters, and add movement to your static scenes for eye-catching
3D animations and movies.

� Using 3DPlus with Other Software. How to incorporate your 3D
creations in graphics, presentation, or desktop publishing programs.

    
“Fog” background effect
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What’s New in 3DPlus 3.0...
Whether you’re a new or returning user, here’s a quick summary of what’s in
store for you. Check the Welcome topic in online Help for direct links from
each feature to its detailed coverage.

♦ Create Your Own 3D Models
With 3DPlus 3, you can now go beyond mere scene-building... step into
the new 3D Workshop and easily construct your own 3D objects using
adjustable QuickShapes, simple drawing tools, or even imported clip art.
The Workshop instantly converts your 2D figures to 3D shapes! Choose
either extruded or lathed projection... control color, outline, and
smoothness for infinite possibilities. Save your creations as separate files
or in the Studio’s Gallery. Absolutely worth the price of admission!

♦ Major Animation Enhancements
The Gallery now comes pre-loaded with dozens of exciting animated
effects that you can apply to text and objects. Check out the animated
lighting schemes... and create your own with ease. You can even
animate the scene’s camera and add creeping fog!

♦ Multiple Scene Planes
The new Planes toolbar lets you carve out a multi-dimensional virtual
space, complete with walls, floor, and ceiling. Switch from grid to solid
rendering, apply flat or shaded colors and textures to individual planes.
Create special lighting effects with cast shadows.

♦ Character-Level Adjustments
Now you can select individual characters within words... change their
color, position, tilt, and other properties... and still move the whole word
as an object or retype its text. Fantastic for animation—create spinning
letters, exploding words, radical color shifts.

♦ New Camera Angle Tool
Now the camera can point at anything in the scene... not just into the
center! Achieve tilts and swivels in all three dimensions with simple
XYZ adjustments. Even move the camera around without disturbing its
custom angle.

♦ Fog and Shadows
Add depth and drama to your creations with these new background and
lighting effects. Simply set the front and back extent for fog... switch
shadow-casting on or off for individual lights.

♦ 3D Print Preview
Check your scene from seven vantage points at once! 3DPlus quickly
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compiles a multiple view that you can review onscreen or print out for
reference and comment.

♦ Camera Light for All-Around Illumination
Don’t get left in the dark! Now every new scene includes a light source
that points wherever the camera does... so you can even see round the
back of scene objects. Switch it on or off as needed, while setting up
your custom lighting scheme.

♦ Export Advances for Animations and Stills
Besides optimized animated GIF export for smaller file sizes, you can
now save animations to the Windows AVI video format, or
automatically output a series of still frames. And 3DPlus now supports
the PNG format, with an alpha channel to preserve transparency in your
Web graphics and video titles.

...Plus These Established Features

♦ 3D Animation Capability
Make any 3D scene come alive! Simply place key frames for the object
properties you want to vary—let 3DPlus generate the in-between motion.
Your objects can move, rotate, change size or color, and much more. The
result: an animated GIF ready for your Web site or presentation.

♦ Ease-of-Use
You’ll appreciate the Wizard interface that simplifies creating new
designs and animations, and the convenient, tabbed Studio bar for tools
and resources. Functions like rotation and extrusion are a snap to apply.
And you can select multiple objects, zoom in or out with a single click,
and use WYSIWYG text entry to preview fonts and formatting.

♦ Extensive 3D Resources
Use the handy branching menus to browse a large set of 3D models—
from basic geometric shapes to complex man-made objects. To
customize your objects and scenes, choose from a collection of
background images, a texture library, and a wide selection of lighting
schemes.
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♦ Powerful 3D Tools
Try the QuickShape tool for adjustable instant objects! Choose from six
preset camera angles, or simply drag for freeform camera views and
object rotations. Experiment with lighting types and controls for brilliant
effects. Easily rotate, resize, and move bitmap textures on any object.

♦ Advanced Performance
3DPlus incorporates its own sophisticated 3D model format. Apply your
choice of textures, colors, and bevels to complex clipart objects, with
separate material controls for front, sides, and back. Built-in DirectX™
support affords speedier 3D rendering—and five anti-aliasing quality
levels let you pick one that’s right for your system.

♦ Customizability
Store your own custom lighting schemes, materials, and bevels as Studio
thumbnails, right there whenever you need them. Import standard
metafiles as 3D models, then weave them into your scenes for a whole
new range of design possibilities.

♦ Direct Output Preview
Forget the trial and error approach! The Export dialog features a built-in
window so you can preview color depth, dithering, and palette settings in
a single step, before conversion. And for top-quality Web GIFs, take
advantage of transparency and background anti-aliasing. And of course,
you can embed 3DPlus scenes directly in publications using OLE. Who
said great results were hard to come by?
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Registration, Upgrades, and Support
If you see the Registration Wizard when you launch 3DPlus, please take a
moment to complete the registration process. Just call Serif toll-free and
provide the installation number and code shown. We’ll give you a
personalized registration number in return. Remember, if you need technical
support please contact us. We aim to provide fast, friendly service and
knowledgeable help.

Installation

What you need to run 3DPlus
Serif 3DPlus runs with Windows 95, 98, 2000, or Me, so you’ll need a PC
setup that runs Windows adequately. If you need help installing Windows or
setting up your printer, refer to Windows documentation and help (see
below).

♦ IBM compatible Pentium PC with CD-ROM drive and mouse (or other
Microsoft compatible pointing device)

♦ Microsoft Windows® 95, 98, 98 SE, 2000, or Me operating system

♦ 16MB (Windows 95/98), 24MB (Windows 98 SE), or 64MB (Windows
2000, Me) RAM

♦ 40MB (recommended install) free hard disk space

♦ SVGA display (16-bit color) or higher

Additional disk resources and memory are required when editing large or
complex documents.

Optional components include:

♦ Windows-compatible printer

♦ TWAIN-compatible scanner and/or digital camera

♦ Internet account and connection required for accessing online resources
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What you need to know
Don’t worry if you’ve never worked with 3D graphics software. 3DPlus
requires no special knowledge. It’s all based on WYSIWYG (What You See
Is What You Get), so WYDKCHY (What You Don’t Know Can’t Hurt You)!
Follow along on the Companion’s guided tours and you’ll be up to speed in
no time.

If you’re new to Windows computing, you will find it much easier if, before
installing and using 3DPlus, you spend a little time becoming familiar with
the operating environment.

� From the Windows desktop, click the ����� button at the lower left and
choose ����.

First-time install
To install Serif 3DPlus, simply insert the CD-ROM into your CD-ROM
drive. The AutoRun feature automatically starts the Setup process. (If it
doesn’t, follow the manual install procedure described below.)

Just answer the on-screen questions to install the program. You will be given
the choice between a Recommended install (which optimizes performance by
loading speed-critical files to your hard drive for best performance) or a
Custom install (which lets you specify the files you want copied to your hard
drive).

3DPlus 3.0 Resource CD-ROM
If you’ve purchased the Resource CD-ROM, we suggest you install it as soon
as you’ve finished installing from the Program CD-ROM. Again, the
AutoRun feature will automatically start the Setup when you insert the
Resource CD-ROM into your drive.

Manual install/re-install
To re-install the software or to change any part of the installation at a later
date, select ����	
��
��
�������
���from the Windows Start menu and then
click on the ���
��������������� icon. Make sure the correct CD-ROM
is inserted into your CD-ROM drive and then simply follow the on-screen
instructions. To install just one particular component to your hard drive,
choose the Custom option and check only that component.
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Starting 3DPlus
Once 3DPlus has been installed, you’ll be ready to start. Setup adds a Serif
3DPlus 3.0 icon to the Programs submenu of the Windows Start menu.

� Use the Windows ����� menu to start 3DPlus, or if 3DPlus is already
running choose ��� from the File menu.

3DPlus launches and displays the Startup Wizard, with these options:

♦ ����������	�
��	���� and �������������	���� let you preview and
select a variety of cool effects, ready for you to customize or use “as is.”

♦ ������ �����!���!" opens a blank scene window.

♦ #��
����������!�
� lets you browse and open your own files.

♦ $	���������� displays a gallery of impressive 3DPlus creations.

If you’re just getting started with 3DPlus, here’s a recommended learning
sequence:

% From the Startup Wizard, choose one of the 3D Wizard options.

& Follow the Wizard’s prompts to quickly create an static or animated
scene (see the next section, Instant designs and animations).

� To begin learning about 3DPlus tools and menus, just move the mouse
pointer around the screen. Watch the HintLine at the bottom of the
screen for capsule descriptions of each feature.

' Choose ����(������ from the Help menu to see what’s available in
online help. The opening screen lets you browse the extensive Visual
Reference, search the Index, or peruse the sequence of How To topics.
Click ������
����� for some tips on how to proceed.
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) Read through the following Companion chapters for self-paced, hands-
on tours of 3DPlus tools and functions.

Instant Designs and Animations…
Creating amazing 3D effects that you can be proud of is easy with 3DPlus.
You can get started right away with the automated 3D Wizards.

� Run the Startup Wizard (*	��
���).

If the Startup Wizard fails to appear, check ���������(���	���� on the
*	��
��� ���
!��+++ screen, then try again.

� From the Startup Wizard, click ����������	�
��	���� or �����������
�	����. In either case, you’ll see the Wizard categories displayed on the
left, with preview thumbnails on the right.

� Browse using the category menu and select a basic design from the
Wizards shown at the right. Then click ����,�to move on to the next
section of the Wizard.

� Type your own text, replacing the sample text, and click ����,. If you
change your mind or want to revisit the choices, click -.�!/�to retrace
your steps.

� On the following screens, make choices as requested—for example, a
bevel effect for edges and a material effect for surfaces—clicking ����,
each time.

� Finally, click a background, then click *	
	�" to complete the Wizard
sequence.

Your new design appears in the 3DPlus scene window.

3D Design Wizards 3D Text Wizards
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If you’ve chosen to create an animated scene, click the  ���0 button on
the Animation toolbar to start playback. (To display the Animation toolbar,
choose ����1��� from the View menu and check �
	���	�
 on the
submenu.)

Note: Choosing a driver setting
If you have a DirectX hardware driver installed on your system, 3DPlus will
use DirectX hardware acceleration to render scenes. Occasionally, driver or
video adapter incompatibilities may lead to display problems such as
difficulty viewing materials on objects, or selecting a particular light source.
If such problems occur, or your scenes just don’t look the way they should,
try switching to the software driver setting.

To select the software driver, choose ��� ���
!��+++ from the File menu and
check the “Software” option.
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Scene center

It’s a 3D World...
The best part of using 3DPlus is that you can create terrific effects without
having to master all sorts of spatial concepts and computer jargon. If you can
grasp height, width, and depth, you’re halfway home! But learning any new
program does involve a bit of trial and error. Here’s some background to help
minimize the “error” part.

The main 3DPlus window consists of a frame (with titlebar, menus, etc.)
enclosing a scene window. Imagine you’re behind a video camera, looking at
a “set” with one or more objects positioned against a background. The
3DPlus scene window is what you’d see through the camera’s viewfinder. As
you’d expect, there are tools to let you rearrange the objects, substitute a
different background image, or change the studio lighting for different
effects. But that’s not all. With 3DPlus, you can instantly change an object’s
colors and dimensions, rotate it in space, apply cool surface textures, create
your own mini-universes of text and shapes, create animation... and more!

New objects appear at the scene center. From the camera’s viewpoint,
looking through the scene window, you see the objects in perspective. You
can reposition objects to be nearer or
farther away, and their sizes change
accordingly.

You can also place lights of various
types around the scene, and vary their
color and intensity for different effects.

Camera viewpoint
Movable

lights

Background

3D Plus
Scene window

Scene
objects
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To set the width and height of the scene, choose �����������			 from the File
menu, or right-click on an empty part of the scene window and choose �����
�����			. Select a unit of measurement and enter the width and height. Note
that your screen resolution setting (800x600, for example) will affect the
actual size of the scene when it’s printed.

At normal view level (1:1 or 100%), the size of the scene window you see
equals the size you’ve specified in Scene Setup. 3DPlus gives you several
ways of adjusting your working view without affecting the actual scene size:

 To zoom in or out, choose the 
����tool on the Tools toolbar, then
left-click on the scene window to zoom in, or right-click to zoom out.

 To adjust the scene window’s size to fit within the main window area,
click the 
�������
���button on the Standard toolbar, or choose 
��� from
the View menu (or the scene’s right-click menu) and select ���
��.

 To restore the scene window to its actual size, click the �����������
����� button on the Standard toolbar, or choose 
��� from the View menu
(or the scene’s right-click menu) and select �����������������.

Each three-dimensional object takes up space in three directions, defined in
3D parlance as the X, Y, and Z axes.

Think of the X axis as defining the
object’s width or left-to-right
dimension, and the Y axis as defining
its height or top-to-bottom dimension.
For example, the X and Y axes define
the black character “a” in this text
object.

The Z axis defines the object’s depth
or front-to-back dimension. It’s this
extra dimension that gives us “3D.”

To learn how to manipulate these and other object properties, follow along in
the next section as we explore the 3DPlus interface.

Z depth

Y height

X width
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Guided Tour: 3D Scenes
You’ve seen how a Wizard helps you create a simple 3D design or animation
in no time at all. 3DPlus is so easy to use, with such compelling effects, that
you’re sure to want to experiment on your own. Starting from scratch with a
new scene is nearly as simple as using a Wizard!

Whether you’re adding finishing touches to a Wizard-based creation or
pushing the limits of your own creativity, the following guided tour will help
you get up to speed. We’ll use � checkbox bullets to mark the ongoing
tutorial thread—steps we’d like you to complete as you follow along with the
text. Save your work occasionally as you go along.

The main purpose of this tour is to introduce you to the various tools—not to
make you an expert! For additional details on each tool and procedure, be
sure to consult online help’s Visual Reference and How To sections.

Making a scene
We’ll begin by creating a new, blank scene window.

� Start 3DPlus or, if it’s already running, choose ��� from the File menu,
and select the “Start from Scratch” Wizard option.

� Take a moment to identify the Animation toolbar, Tools toolbar, and
Planes toolbar, and the six Studio tabs on the right.

Your screen will look something like the illustration below. You may wish to
resize the main window to bring the tools a bit closer to the scene window,

and also click the 
�������
�� button to maximize the working area.

The lattice of blue lines in the center is the Floor plane, one of six planes
you can display as layout guides or scene elements. The Floor plane slices
through the scene center at the zero point of the scene’s Y (vertical) axis.

Studio
Tools

toolbar

Animation
toolbar

Planes
toolbar
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Initially the camera is elevated five degrees above this plane, affording a
perspective view. For the moment, let’s hide the Floor plane so the scene
window is blank.

�  On the Planes toolbar, click the Floor plane’s ������ button to
hide the plane.

And at this point we don’t need either the Planes toolbar or the Animation
toolbar, so we can hide them.

�  Hide the Animation and Planes toolbars by clicking the ����� button
on each one.

The object of the exercise
Adding 3D models, also called “objects,” to the scene is a snap!

� Click the Studio’s �� ��� tab to reveal the Basic Shapes category. Click
the Pyramid shape (third row down in the middle).

3DPlus locates the model on the CD-ROM and creates a new pyramid object
at the scene center. (For future reference, you can also drag models from the
Models tab and drop them at a specific position.)

The pyramid, like all the basic shapes, has a white color by default, and no
special texture or other attributes. Initially, what you see is a front view of the
object, which is why it looks like a triangle. Let’s prove that it really has
three dimensions.

The right tool for the job

�  On the Tools toolbar at the left, click the button for the !����������.
Immediately, a set of labels appears, centered on the pyramid. (If you
don’t see the labels right away, just click on the pyramid to select it.)

The labels and lines plot the three axes of the
3D scene. As you might expect, the X axis is
horizontal, the Y axis runs vertically, and the Z
axis—the depth plane—runs straight from our
viewpoint into the scene center, which is why
we can’t see its axis line.
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Hotspot� Click on the “Y” axis label with the Rotate cursor,
being sure to click with the cursor’s “hotspot”—a
single dot, as shown here. Drag from side to side,
then up and down. Now try the same thing, only
dragging the “X” axis label, and then the “Z” axis
label.

And there it is: 3D!

As you’ve probably noticed, dragging up has the
same effect as dragging to the right; the down and
left mouse actions are similarly paired, a 3DPlus
convention.

By the way, 3DPlus features multiple levels of
undo (which you can set in 
����"�����#�����			)—
so if you seem to have rotated your pyramid
hopelessly out of alignment, you can always backtrack...

Let’s continue to explore the offerings on the Tools toolbar, using the
pyramid as a sort of geometric guinea pig.

�  Click to select the ��$����%������.

As its name implies, this tool handles two functions. If you click directly on
an object, you can drag it around in the scene along the X or Y axes. (Its
distance from the camera, or Z-distance, doesn’t change.) Alternatively, you
can click one of the object’s handles—the red dots at the corners of the
selection—and drag to resize it. (In this case, the object responds by growing
or shrinking in three dimensions, although its center doesn’t move.)

� Try moving and resizing the pyramid. Watch for the special cursor that
appears when you’re over a handle: it tells you that dragging will result
in a resize operation.

Before proceeding, let’s make life a bit more interesting by adding a second
object to the scene—this time, a QuickShape.

�  Click the little down arrow on the &������'���(�)��������, third
from the bottom on the Tools toolbar. (The actual button icon varies,
depending on which shape you selected most recently.) From the flyout
menu that appears, choose the “Moon” shape (third row, left). The cursor
changes to a light bulb icon.



22    Working with 3D Scenes

� Click in the scene window and drag
sideways with the light bulb cursor until
a crescent shape appears and is roughly
as big as the pyramid object. When you
release the mouse button, you’ll see a
slider and two small buttons.

You can adjust the outline of any QuickShape by dragging its slider(s). In
this case, the single slider varies the “phase” of the moon object.

� Experiment with the slider, leaving the moon
as a typical thin crescent shape. Then click the

 button to confirm the shape. (Clicking 
would cancel it.)

As with the pyramid earlier, the moon object
initially appears in straight-on front view.

� Use the Rotate tool to swivel the moon to a
more interesting angle.

 The next item on the Tools toolbar is the ������)�����, which lets you
adjust a single object’s size along one dimension at a time—for example, to
make it thicker or thinner without changing its height or width.

� Select the Stretch tool and click on the moon object.

Again, you’ll see axis labels; but this time they represent the axes of the
object itself, as it’s currently positioned in space. To make an object wider,
drag out on its X axis. To reduce its height, drag down on its Y axis, and so
on.

� Experiment with the tool until you get accustomed to the changes along
each axis. Then return the moon to its original shape, more or less.

� Choose the Move/Size tool and drag the
moon down until it intersects the pyramid.
Both objects are still centered the same
distance from the camera; where they take up
the same space, they overlap with intriguing
results.
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To choose: Press:
Move/Size tool ����*�
Rotate tool ����*+
Stretch tool ����*,
Distance tool ����*-

 The .������������ lets you move an object’s center along the scene’s Z
axis—in other words move it closer to (or further from) the camera
viewpoint. This lets you place one object in front of another in your scenes.

� Choose the Distance tool and click on the moon object to select it. Now
drag the object slightly down (or right). Doing so decreases the Z-
distance and brings the object closer; dragging up or left pushes the
object away. Although the object appears to grow or shrink, bear in mind
that it hasn’t actually changed size—only position.

TIP: You can select multiple objects by holding down the �)��� key when
selecting each object, or by dragging out a marquee around a group of
objects. Then use any of the basic tools to edit the resulting multiple selection
as if it were a single object.

TIP: In working with objects, you’ll
often find yourself switching between
the first four tools on the Tools
toolbar.
Use the shortcuts shown at right to
jump quickly from one tool to another.

�  Next, click the ��/������.
Immediately, a text edit window pops up. Type a couple of words (we
chose “Nile Style”) and pick a font from the drop-down list (we applied
Stylistic SF). Click �0.

The text you typed appears in the scene
as a new text object (front view, of
course.)

� Use the four basic tools (Move/Size,
Rotate, etc.) to adjust the text and
place it in relation to the other
objects.

You can edit any text object by selecting
it, then using the controls on the Standard
toolbar to change font, alignment, and so
on. To bring up the text edit window
again, simply double-click the word
object—then you can retype the text as needed.
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You can edit single characters, too! The first time you click on a text object,
the whole word is selected. Each subsequent click selects only the character
under the tool. (To reselect the whole word, first click somewhere else to
deselect it, then click the word again.) By selecting individual letters, you can
adjust their position, color, or other attributes,
which opens up a whole range of design options.
For example, at right we’ve slightly enlarged
and rotated the letter “N.” For details on
working with text, see Chapter 5.

� If you haven’t yet saved your work-in-progress, do so now using

������$� or the toolbar button.

Different viewpoints
So far, we’ve covered tools that affect selected objects in the scene. The
Tools toolbar also includes three tools that let you alter the camera viewpoint,
thus changing the appearance of the scene as a whole. Let’s take a quick
look.

� Click in a blank part of the scene to deselect all objects. Notice that the
HintLine readout below the scene now shows values for the camera.

The current “camera position” value is given as “0º 5º”, denoting a 5-degree
elevation in the vertical plane. This is the default starting camera position for
new scenes, and we haven’t changed it since starting the tour.

�  Click the small down arrow on the �������"��������button. A
flyout menu appears, with seven choices. Move the cursor over the
choices and you’ll see six of them are fixed camera positions: Front,
Back, Top, Bottom, Left, Right.

� Click each of the preset buttons in turn and watch as the scene changes.
As you do so, keep an eye on the HintLine readout.

The HintLine values describe how far the camera’s position deviates from the
straight-on Front view (which is “0º 0º”). If the camera moves horizontally
from this Front view, the first value changes; vertically, and the second value
changes. (For more, consult the online help topic on the Camera Position
tool.)

TIP: At any time, you can choose 
����,.�"�����"��$���			 to see the current
scene from seven viewpoints at once (see end of chapter).

Don’t think you’re limited to just the six preset vantage points! You can
achieve unlimited “free orbit” camera motion simply by dragging with the
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Camera Position tool.

� After clicking any of the fixed-
position buttons, move the mouse
pointer over the scene window, then
click and drag—up, down, left, right.
You’ll see the view change
continuously.

� Experiment with various dragging
motions until you begin to get a feel
for manipulating the camera viewpoint.

Conveniently, the Camera Position button “remembers” your last freeform
setting. Let’s try it.

�  Click any of the fixed-position buttons on the flyout to restore a
preset view. Then click the 
������1�� button on the flyout—and the
scene snaps back to your previous Free Orbit position.

�  Continuing down the toolbar, next choose the �������2�3�������.
A set of XYZ labels appears in the scene window.

The labels are just like those you used with
the Rotate tool—they represent the three axes
of the scene itself—but this time they aren’t
centered on a particular object. Instead, think
of the invisible camera as an object with the
axes running through it. You can swivel the
camera like an object around any axis by
dragging from the corresponding label.

� Click on the “Y” label and drag left and right. The scene appears to shift,
as if the camera were panning from side to side. It’s pivoting around the
Y axis, as shown in the illustration. Try dragging the “X” and “Z” labels
while visualizing the camera’s motion around those axes. The HintLine
readout may help.

TIP: After changing the camera angle, you can still move the camera freely
while maintaining the custom angle. Click the �������"������� button on
the toolbar (which will be displaying the Free Orbit icon), then hold down the
�)��� key while dragging in the scene window.

� Finally, choose the �������.������������ and drag in the scene window.
Again, the whole scene changes. This perspective adjustment can be
useful for trimming (or adding) extra space around the edges of the scene.
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Some local color
Up to this point, we’ve been content to leave all the objects in the scene in
their original, rather pallid condition. And in fact, we’ve got a nice grayscale
composition going. But before concluding the tour, let’s liven things up a bit.

In 3DPlus, there are three basic ways of adding color to a scene. Each
involves using one or more of the Studio tabs on the right side of the
workspace.

To... You can...

Change the scene
background

Use the Backgrounds tab to select a solid
color, image, or fog (see below) as a
background

Change the base color
of individual objects

Use the Materials tab to select a base color
for a selected object

Change the scene’s
color scheme

Use the Gallery to select a preset lighting
scheme, and/or

Use the Lights tab to customize the scene
lighting, adding lights of different colors

We’ll look at a couple of these techniques by way of introducing the Studio,
and let you have fun exploring the others on your own.

�  Click the ��������� tab button.

When we speak of an object’s “material,” we’re talking about a set of surface
properties that you can vary, and which are saved along with the object. Base
color is just one of these properties. (The others are texture, transparency,
and shine.) The Materials tab lets you tweak an object’s material definition
by adjusting each of these attributes independently. For now, we’ll just focus
on color.

� Using any of the basic tools, select the moon object. Now click any color
swatch in the scrolling table at the bottom of the Materials tab. Click
another swatch.

With each click, the object’s color changes. (We prefer a yellow moon, but
you may have your own ideas!) By the way, the multi-colored swatch at the
upper left of the color table represents “Original Color”—click it if you want
to restore an object to its initial base color.

� Experiment with coloring each of the three objects in the scene until you
find a pleasing combination.
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Shedding light on the situation
Taken together, all the lights used in a scene are known as the scene’s
lighting scheme—and every scene has one. In addition to the Camera Light
and Floodlight that are standard in every new scene, 3DPlus provides four
different types of light sources (spot, ambient, distant, and point) that you
can mix and match in any number or combination. Although each type of
light has its own special properties—detailed in online help—one thing they
have in common is the ability to take on a particular color. You can use
multiple lights of different colors, in different positions, to create subtle
interactions with the base colors of scene objects. And you can even produce
animations where lights move or change color between frames.

To get a feel for how the lights work, let’s look at a couple of them.

�  First, click the 
�����view button on the Camera Position flyout so
that you’re looking at the scene straight-on.

�  Click the 4�3)�� tab button and notice the scrolling region in the
center of the tab. At this
point, there should be just two
entries: “Floodlight” and
“Camera Light.”

� Click the light bulb icon (������ button) next to the Camera Light’s
name to turn off the light. The scene goes dark! Click again to restore
illumination. Note that the Floodlight is already switched off; this is the
default setting for new scenes.

� Now click the Floodlight’s ������ button to turn it on also, and then
turn the Camera Light off. From this front camera position, both lights
have very similar effects—but now for a surprise.

�  With only the Floodlight switched on, click the 5��(�view button
on the Camera Position flyout. Again, the scene darkens—but why now,
if the Floodlight is still on? (Hint: Try switching the Camera Light on
and off, and try a side-view camera position.)

As you may have observed, the Floodlight only shines from the front of the
scene, hence it can’t illuminate the back of any objects. On the other hand,
the Camera Light (as its name implies) is “mounted” on the camera, thus
always points inward from the camera’s current position. The Camera Light
can certainly help you see a scene from any viewpoint, but you may want to
switch it off in favor of a more realistic directional lighting scheme using
other available sources.
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� Reset the camera to its front position, with just the Floodlight on, and
select the Floodlight by clicking its name on the Lights tab. In the swatch
panel at the bottom of the tab, click any color.

Now the scene is bathed in a vivid glow. Notice that the swatch to the right of
the “Floodlight” entry has now taken on the color you chose. Changing the
color of a light is as easy as changing an object’s base color.

� Drag the &�������6 slider to the left, and you’ll see the scene fade as the
floodlight’s output dims. Leave the setting about halfway.

�  Near the top of the tab, click the &������������3)� button.
Right away you’ll see a change in the scene, as a spotlight object appears
in the center and casts a default hue of its own on the surroundings. To
choose a different hue, click a color swatch.

Spotlights, point lights, or distant lights that are turned on in a scene appear
as objects as long as the Lights tab is selected. You can use the basic tools to
reposition them. (The Floodlight, Camera Light, and ambient lights don’t
appear as objects.)

� Switch the Floodlight off, so that only
the spotlight remains on. Using the
Move/Size tool, drag the spotlight
object from side to side. You’ll find
it’s like shining a beam around in the
dark.

� Now try the Rotate and Distance tools on
the spotlight object. You’ll see the beam’s
width change as you move the light in or
out with respect to the scene. Try swiveling
the light to illuminate specific objects. It
may help if you visualize the light as a bulb
inside a housing, with its beam projecting
forward, as shown at right.

You can investigate the other light types at your
convenience. We suggest you continue the same approach: turn off
everything but the one light and then play around. (For details on each light
type, search for “lights” in the online help index.)

In the meantime, let’s not overlook that the Studio’s Gallery tab is well
stocked with predefined lighting schemes, material definitions, and bevels—
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so you may find exactly the effect you need without any extra effort!

�  From the Lights tab, click the �����7�����6 button to
open the Gallery tab’s Lights section directly. You’ll see an array of
preview thumbnails, each depicting a different lighting scheme.

� Click a few thumbnails in turn to see how each one affects the scene. To
see which lights and settings make up any particular scheme, just apply
the scheme, then click the 4�3)�� tab button. (It’s another good way to
learn about the various light types.)

Finally, note that the Gallery includes a “My Gallery” section where you can
store your own custom lighting schemes and materials (there’s a
corresponding section on the Backgrounds tab, too). Saving custom effects is
simply a matter of right-clicking on an object or scene.

� Save your scene as a .3DD file—perhaps using a different file name if
you’ve made major changes since the last save.
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The plane truth
To end this guided tour, let’s return to a feature we mentioned only briefly at
the beginning: the Planes toolbar. This lets you control up to six surfaces
that function like the walls of a “virtual room” within the scene. You can use
these planes simply as visualization aids, or include them as part of the final
scene. Now let’s explore how to use the toolbar and Studio to apply colors,
textures, and shadows to planes.

� To simplify things, we’ll start with a blank scene. Choose New from the
File menu and select the Start From Scratch option.

As before, the new scene has a visible Floor plane slicing through the scene
center.

� If the Plane toolbar isn’t visible, choose ����1��� from the View menu
and check "����� on the submenu to show it. Move the toolbar to a
convenient location.

 On the toolbar, note that the Floor plane’s ������ button is in the “On”
state. At the moment, all the other planes are turned off.

� Switch on the Back and Left planes by clicking their ������ buttons on
the toolbar.

Now the scene shows three planes that meet at a corner. (For a slightly wider
view, you can use the Distance tool to zoom back.)

� Choose the �������"������� tool and drag randomly in Free Orbit
mode to get a better sense of how the planes define a space within the
scene.

TIP: Using the 
����"����������			 dialog, you can make all scene planes
larger or smaller by changing the “Extent” setting. To make the grid squares
larger or smaller, adjust the “Grid Size” setting.

� On the Studio’s �� ��� tab, click any thumbnail to bring a new object
into the scene. (We’ve selected a Torus Knot.)

Assuming you clicked the thumbnail rather than dragging, the new object is
sitting precisely at the scene center. (If necessary, check the HintLine and
drag the object to the “0º 0º 0º” position.) You can see clearly where the three
planes reside in relation to this center point.
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�  On the Planes toolbar, click the 
���
button (third from the left) for the Floor
plane. The plane changes from a grid to a
solid surface. Note that clicking the
button has also selected the plane on the
toolbar.

� With the Floor plane selected, select the
Studio’s ��������� tab, then click any
color swatch to apply it to the plane as a base color. (You’ll also see the
base color appear to the right of the plane’s name on the toolbar.)

� Select the 4��� plane by clicking its name in the toolbar, and then apply
any different color from the Materials tab. This just proves that colors
work on grid planes, too.

� Click the 
��� button for the Back plane and select the Studio’s 7�����6
tab. Open the “Bricks & Tiles” category and click a brick texture
thumbnail.

Planes set to Grid or Flat mode always appear
in their pure base color—exactly matching the
toolbar swatch—regardless of the scene’s
lighting scheme. If you want a plane to
respond to light sources, you’ll need to set it
to Shaded mode.

�  Click the �)� �  button for the
Floor plane.

� The plane is still using the same base color, but appears much duller than
before. That’s because it is now responding to the limited output of the
Camera Light. To brighten up the plane, we’ll need to add another light.

�  On the Studio’s Lights tab, click the &������������3)� button.
Drag the spotlight to the upper left of the scene. To accentuate its effect,
tilt it downwards using an X-axis adjustment with the Rotate tool, and
widen its beam by dragging the Hotspot slider to the right. With proper
positioning, you should be able to illuminate the Floor plane fully,
matching the base color shown on the toolbar.
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� With the spotlight still selected, click the
�)� ���������� button next to its
name on the Lights tab. With shadowing
on, any object in between the light source
and a Flat or Shaded plane will cast a
shadow. There’s only one object in the
scene, so move it up and around a bit to
see its shadow. If necessary, adjust the
spotlight’s angle or other properties for
best effect.

That completes this survey of the 3DPlus scene window and its basic tool set.
Everything we’ve touched upon is covered in greater depth in online help—
but you already know more than enough to continue exploring and
experimenting on your own. The following chapters take a similar approach
to the 3D Workshop, which lets you create your own objects from scratch,
and the Animation toolbar, with which you can add motion to existing 3D
scenes.

3D Print Preview
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Welcome to the Workshop
If you’ve explored the Studio’s Models tab, you may have noticed that a
number of the objects provided there include a small  symbol in their
thumbnails. That symbol denotes objects that were created directly in 3DPlus
using the 3D Workshop.

The Workshop provides an easy-to-use environment where you can not only
customize these native 3DPlus objects, but create your own from scratch. You
can save the objects as separate files (using the .3DW extension), quickly
transfer them into any scene, and store them conveniently in the Studio to
reuse later.

And you don’t have to be a master craftsman to use the Workshop—a few
basic concepts will carry you a long way. In this chapter we’ll take a leisurely
stroll through the facility and explain the various tools as we proceed. Come
on in—no safety goggles required!

Guided Tour: The 3D Workshop
The 3D Workshop is a special-purpose window within 3DPlus that, when
launched, takes over from the main scene window. There are two basic ways
to launch the Workshop. If you’ve already brought a Workshop-created object
(with a ) from the Models tab into the scene window, you can simply
double-click the object to edit it. Or, to start from scratch, take this direct
approach:

�  Click the ��������	�
 button on the Tools toolbar.

The window changes into the 3D Workshop, with its own toolbars, drawing
region, Preview window, and controls.
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In a nutshell, the creation process works like this. First, you outline a two-
dimensional (2D) figure, using any of the available drawing tools. Once
you’ve closed the outline on itself, the Workshop projects the closed shape
into 3D space and displays an animated preview. You can edit the original
figure, change its colors, and adjust various attributes until you’re happy with
the 3D object, at which point you transfer it into the 3DPlus scene window
and exit the Workshop.

Let’s take things one step at a time, and have some fun.

From 2D to 3D

�  On the left toolbar, click the ���
���������	�

 button.
(QuickShapes are also supported in the main window, and were covered
in the previous chapter.) Choose the “Donut” shape (top row, right) and
drag out a shape in the drawing region. Hold the �	��� key down when
dragging to obtain a circular shape.

The QuickShape is already a closed 2D figure, of course, so as soon as it
appears, its 3D projection starts animating at the right. Let’s make a few quick
observations.

Preview
Window

Toolbars

Drawing
Region

Controls
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� Check the � box in the Rotation panel, just above the Preview window.
With both X and Y checked, the shape rotates around two axes rather
than just one. Try checking the � box also, and then uncheck one of
them. Rather compelling, isn’t it?

� Now click the ���
 button, and then the �
�
� button. Right away the
shape snaps back to its original orientation, matching the 2D figure.
Click ���� again to resume the preview motion.

Now it’s the QuickShape’s turn for some attention.

� Click the top button on the left toolbar to select the ���������, then click
the QuickShape to select it. Drag any of its adjustment handles to see
both the 2D and 3D shapes respond. Can you turn the donut into a tiny
sliver?

If you’ve played with QuickShapes in the main window, you’ll notice that
there are no “Accept” or “Cancel” buttons on this QuickShape. That’s the
key advantage of creating them here in the Workshop: they remain editable
indefinitely—you can switch to other tools or change settings, and still return
to the shape to make more adjustments.

With the QuickShape still selected, you may be
wondering about the three little boxes at its lower right. These
color handles afford a direct way of applying color
to (respectively) the front, back, and sides of a
Workshop model.

� In the Color gallery below the preview window, click the red swatch and
drag it over to the object’s first (i.e. left) color handle. Now repeat this
with the adjacent green swatch, but this time drop the color on the
second color handle. The rotating preview will reveal that front and back
are now differently colored.

� Here’s another way to apply color. Right-click the blue swatch (next in
line after the green one) and choose �

���������
�. Note that the other
options are on the menu, too, including �

���������, which could save
you some steps if you want the whole surface the same color.

While the object is still multi-colored (red, green, and blue), let’s test-drive
another set of Workshop controls and get a simple demonstration of RGB
color mixing.

� In Lighting panel at the right, drag the � (Red) slider all the way to the
left, to turn off the red component. The front face of the object, which
was red a moment ago, is now black—because there’s no red light to be
reflected.

Front  Back  Sides
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� Now drag the   (Green) slider to the left. With both red and green
components gone, both front and back of the object appear black.

� Right-click the white color swatch and choose �

���������. Now that
the object’s base color is back to a pure white, it appears solid blue under
the single remaining (blue) light source.

� Slowly fade up the � and   sliders and watch the object reflect various
mixtures of the three primaries. With all three sliders back up to
maximum, the shape appears white once again... a nice way of showing
that red, green, and blue add up to white light.

The main window’s Lighting controls are independent of those in the
Workshop. As we’ve just seen, in the Workshop you can use the color
swatches, lighting controls, or both, to achieve a particular coloration. When
you transfer the object to the scene, however, any color applied to it in the
Workshop becomes simply its base color. The scene’s own lighting scheme
will be superimposed on that to create a final effect.

Any time you want to transfer a Workshop object to the scene, simply click
the !" button at the lower right. (You can resume editing the object later by
double-clicking it in the scene to launch the Workshop.) Clicking #���
�
returns to the main window without transferring the object; you’ll lose any
unsaved changes in the Workshop. To save the Workshop contents at any
point, click the ��$
 or ��$
��� button. You can load previously saved
objects using the !

� button.

Turn, turn, turn
Impressed with the 3D Workshop so far? Hold on, here comes the best part!

� By now, your “donut” QuickShape may have morphed considerably
from its original form, so it’s probably best to start over with a new
shape. You can either delete the old one (simply select it and press
�
�
�
), or click the %
& button to clear the drawing region. Then drag
out a new donut as before.

� Select the new QuickShape with the Edit tool and adjust its right handle
to rotate the shape so it’s oriented like the letter “C.” The shape should
be roughly centered in the drawing region. Finally, in the Rotation panel,
check only the ' box, leaving � and � unchecked.

� Now select (��	
� in the Creation panel at the right.

In the Preview window, the 3D projection turns into a flat shape that looks
like a pulley of some kind. What’s going on? A single trial adjustment will
reveal all.
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� In the Creation panel, drag the �
)�

�
slider to the left about halfway. Now the
Preview window shows only half of the
pulley—and you can clearly see it has a C-
shaped cross-section that matches the 2D
figure.

Just as a real-world lathe turns a workpiece around a long axis so it can be
carved or shaped, Lathed mode takes the 2D drawn shape and revolves it
around an axis line to produce a 3D projection. The Degrees slider lets you
achieve a partial turn, anywhere from a full 360° down to a mere sliver.
Previously, we were working in Extruded mode, where the flat 2D figure
was simply extended a bit along the Z axis to give it some depth.

� Drag the 2D shape toward the dashed red axis line at the left side of the
drawing region. Notice that the hole in the middle of the “pulley” gets
smaller as the space between the shape and the axis decreases.

� Check the � box to add X-axis rotation. Wait until the 3D shape comes
round to a position where you’ve got a clear view of its various profiles,
and then click ���
 to freeze it. (You may have to click ���� and ���
 a
few times to achieve the best angle.)

� Now for some experimentation. Try adjusting one or more of the
QuickShape’s handles in small increments, and notice how the 3D shape
changes. (If you wish, restore the �
)�

� slider to its full-turn
position.) See what happens if you drag the figure beyond the axis line:
anything to the left of the line will be ignored.

� Drag the �*���	�
�� slider all the way to the left. The result: a three-
sided shape, but still with the 2D figure as its cross-section. Jog the
slider little by little to the right, and you can add one side at a time.
Interesting possibilities here!

� Just for fun, switch back to Extruded mode, which now looks tame by
comparison (but no less useful).

Well, that’s it for Lathed mode. Who would have guessed that a humble
donut could shape-shift into such varied forms? It’s staggering to consider
what you can achieve in the 3D Workshop using QuickShapes alone. Still,
you won’t even approach the Workshop’s limits until you’ve tried its
drawing tools. For an introduction, step right along to the next section.
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Drawing shapes

�  Click the %
& button to clear the drawing region, and select
�+����
� mode for a simpler 3D preview.

�  Click the ,�

	�������� button. In the drawing region, click for a
starting node, then drag with the tool to draw something approximating a
circle. End the line where you began it—on the starting node—to close
the shape. The extruded projection appears instantly in the preview
window.

� Press #���-� to undo the drawing, and try again. This time, trace
something with a wavy outline, such as a head in profile or an imaginary
island.

� Clear the screen again and draw an
incomplete curve (not a closed figure), then
click (without dragging) somewhere else.
Click a third time and drag out a short
segment, then end by clicking the starting
node. The numbers in the illustration show
one possible sequence.

With the Freehand tool, clicking to place a new node automatically connects
it to the previous node. Dragging from an existing node (including one
you’ve just placed) attaches a curve in any shape you draw.

�  Select the ��������� and notice the distribution of nodes around the
outline. (It doesn’t matter if your figure differs somewhat from the
illustration above.)
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� Now for a small challenge. Using only the Edit tool, see if you can

transform your shape into something like
this...

Need a hint? Dragging a line segment is the
easiest way to change the figure’s shape. You
can drag nodes, too, to change their position.
Watch the tool cursor to see whether you’re
over a node or a segment.

The last key point about freehand drawing and editing concerns nodes, which
are slightly more complicated than they first appear.

� Drag each node of your figure in turn, moving it slightly away from the
center. Don’t worry about the resulting shape; just separate the nodes
from each other.

You’ll notice that certain nodes—at the junctions where you initially clicked
a separate point and 3DPlus drew a connecting line—are actually pairs of
nodes that you can drag apart. These extra nodes in a drawn figure are
normal, resulting from the Workshop’s attempt to
match the shape you drew.

� Look for any node that joins two curved-line
segments (the tool cursor on each side should
show a wavy line). Click the node to select it.

You’ll see two green lines heading off in separate directions from the node.
These are called attractor handles and they let you
fine-tune the shape of a segment where it adjoins a
node. You can precisely adjust the slope or angle at
which a segment leaves a node, and also the
segment’s depth, i.e. how much it bulges in or out.

� Try dragging one handle, then the other, to see how the segments
respond. Now try dragging some nodes elsewhere along the figure.
You’ll notice that nodes joining a curve to a straight-line segment have
only one attractor handle, which makes sense because the straight line
has a fixed slope and depth.

In any figure you draw from scratch, the nodes initially will be of the sharp
variety—that is, the segments on either side of the node are completely
independent of one another. For more rounded contours, you can use the
buttons on the Node Edit toolbar at the lower left to convert a node to either
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smooth or symmetric. Smooth nodes force the adjoining segments to assume
the same slope, although they can have different depths. Symmetric nodes
produce perfect rounding, where the segments have the same slope and
depth.

                      

� To convert a node, select it and then click a node type button. Take a
moment to try converting one or more nodes to smooth or symmetric,
then drag the segments on either side to see how the figure responds.

Note that the Node Edit toolbar also includes a Straighten Line button,
which straightens out the segment on the trailing side of a node, and a Delete
Node button, which helps to simplify a shape.

�  Click the (��
����� button and create a new shape by clicking to
place each corner point of the figure. The connecting lines are drawn
automatically, and this time you only get single nodes at each junction.

You’ve probably noticed—but it’s worth emphasizing—that the drawing
region can handle any number of separate objects, which appear in the
Preview window (and when transferred to the scene) as a single, composite
object. It’s a valuable technique for adding extra protrusions and contours, or
if you’re creating complex models like those in the 3DPlus Studio, for
example.

�  To complete your survey of the drawing tools, click the #��$
�����
button. This tool works like the Line tool—you click to place a series of
points, which are automatically connected—but in this case the
connecting lines are curved. You can drag after each click to adjust the
new node’s attractor handles and roughly shape the preceding segment.
Now that you know about nodes and segments, you should find the tool
straightforward to use.

Text and more
Before winding up this tour, let’s briefly survey some of the other tools and
functions that add convenience and power to the 3D Workshop.

 The Workshop has a Text tool that works very much like the standard
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Text tool in the main window (see the previous chapter). In the Workshop,
only individual characters—not whole words as in the main window—are
selectable. Generally speaking, type single characters into the text creation
window. The tool is most useful for creating single “dingbat” characters, or
supplying letter shapes as a starting point for creative distortions.

 Another creation option is the Insert Metafile button, which lets you
import a .WMF or .EMF file created in an outside program. Imported
metafiles are converted to multiple complex polygons, typically with more
nodes than you’ll want to edit—but they are easily scaled, and this is still a
convenient method of bringing external content into a 3DPlus scene.

  Click the Zoom In and Zoom Out buttons to adjust the working
view.

 The Zoom to Fit button resets the view to its initial state.

 To turn on a point grid as a drawing aid, click the Snapping button.
With the grid turned on, nodes you draw “snap” to the nearest grid point—
especially useful when drawing straight-edged figures.

 Click the Show/Hide Nodes button if necessary to reveal the nodes for
editing, or conceal them for a clearer view of the figure.

 Use the Preferences button on the top toolbar to adjust the grid color
and spacing, or to set the background color of the drawing region.



Working with 3D
Text & Animation
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Editing 3D Text
Text takes on a whole new significance when it leaps out at you in 3D. Flat
typography turns into sculpture with the addition of a depth plane. Even
single characters begin to resemble intricate carvings or profound monoliths.
Add to that the possibilities of animating color, shape, and positional
changes, and there are virtually no limits to where you can take text in
3DPlus!

 If you’ve followed the guided tours in the preceding chapters, you
already know how to enter text using the Insert Text tool, found both on the
main window’s Tools toolbar and in the 3D Workshop. You know that
selecting the tool pops up a text edit window where you can enter your text,
and that you can double-click a text object in the scene to edit it some more.
And you can always enter text by pasting it via the Windows Clipboard. This
section will cover a few additional things you should know about text
objects, particularly if you intend to produce (or edit) animated text using the
techniques discussed later in the chapter.

The key point is that you can edit text objects either at the word level or the
character level—that is, as either word objects or character objects. The
first click on a text object selects the word object, while subsequent clicks
select individual character objects for editing. To reselect the whole word,
first click elsewhere to deselect all characters; then click the text object to
start the cycle again.

♦ For either word or character objects, you can alter properties like
position, size, stretch, and rotation using the standard tools on the Tools
toolbar.

♦ To change the object’s bevel (edge contours), apply a preset from the
Studio’s Gallery tab, or customize the bevel using the Studio’s Bevels
tab.

♦ Chapter 3 introduced the concept of a material definition (consisting of
an object’s base color, texture, transparency, and shine attributes). For
either word or character objects, you can use the Studio’s Gallery and
Materials tabs to apply these material attributes independently to the
front, back, and/or sides of the object. We’ll return to materials in a
moment.

Wingdings characters
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Character formatting repeats if you add new characters to the word. That is,
the first new character takes the formatting of the first old character, the
second follows the second, and so on. As an experiment, we started with the
three-character word “ABC” (1), and adjusted the position and rotation of
each character separately as in (2). Then we used the Text window to add the
letters “DEF” with the result shown in (3). You can see how the formatting
repeats in the added letters.

This rule of “repetitive formatting” applies to any individual character
attributes you alter, including color, bevel, etc.

As for other objects, you can save a text object’s material attributes to the
Gallery for future use. Simply right-click the word or character and choose
����������	�
���. A thumbnail appears in the “Materials” section of the
Gallery tab’s “My Gallery” category. Repetitive formatting pertains here,
too. When you save a word object’s material, you’re actually saving the
sequence of material attributes used in that particular sequence of characters.
The definition thus incorporates a repeating pattern based on the number of
characters in the word. Note that positional information does not get saved as
part of a material definition.

In the example below, we started with a two-letter text object and set the first
letter light gray, the second one dark gray. Then we selected the whole word
and saved its material. The same material was then applied to the longer text
object: you can see how the light/dark pattern has repeated itself.
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Animation Basics
The animated Samples included with 3DPlus are sure to inspire you to create
your own animations. Before you spend time creating an animation from
scratch, check in the Animations category of the Studio’s Gallery tab for a
collection of preset animation sequences that you can simply click to apply to
any selected object. Some of the preset lighting schemes on the Lights tab
also feature animation where lights change colors or position.

Another easy way to get started is to choose the 3D Text Wizard option
from the Startup Wizard screen. Once you’ve selected and customized one of
the animated examples, click �	
	�� to bring it into the scene window.

The Animation toolbar appears once you’ve loaded an animation. (Or choose
���
���� from the View menu and check �
	���	�
.) You’ll see that the
Animation toolbar consists of a basic Control Panel for playing back
animations and (when expanded) an Edit Panel which lets you edit existing
animations or create new ones. You can drag the toolbar outside the main
window to increase the available workspace. Here’s the toolbar’s Control
Panel:

The first set of three buttons are �
��, ����, and ������������. Use these
to preview the animation directly in the scene window. The second set of
buttons serve to set the playback mode. Click �	
�
����
 to play the
sequence once, stopping on the last frame. The next button, �	
����
�, plays
the sequence indefinitely—first forward, then backward. Finally, the ����
button also sets up an endless repeat condition, this time repeating from the
first frame each time.

3DPlus animations are just like static scenes, but with multiple variations
stored as frames. (We’ll explain more about frames below.) In order to use
an animation on a Web page or in a presentation, you’ll need to export it to a
standard format known as animated GIF (originally pronounced to rhyme
with “riff”) or to the Windows AVI movie format. Options that you set using
the Animation toolbar, such as playback mode and speed, are incorporated
into the animation when it’s converted to a GIF or AVI.
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To understand how animation works in 3DPlus, consider a basic 3D scene
with several objects. Instead of pointing a still camera at the scene, imagine
we’re using a movie camera that lets us expose one frame at a time. Between
each exposure, we can adjust one or more of the scene objects (which may
include text objects, lights, or camera) in various ways. We might change an
object’s position over time, so that it appeared to move from one side of the
scene to the other. Or we might change its rotation angle, so that a sphere
appeared to spin on its axis. Once we’ve shot a series of frames, we can play
them back rapidly and see the motion unfold.

Creating animation in 3DPlus is a fast and flexible process. In general, you
first decide how many frames you want in the sequence. Then you issue
instructions to the scene objects, telling them how to behave during the
sequence. Naturally, each object that will change needs its own set of
instructions. For each such object, you’ll specify which properties need to
vary, and define several key frames that show the object exactly as you want
it to appear at that point in the sequence. 3DPlus takes care of the rest: it
examines the key frames and automatically generates “in-between” frames
that take care of the transformations. The result is a seamless animation.

For each object, you can set key frames for Position, Size, Rotation, Texture,
Color, and Transparency. For the scene as a whole, you can set key frames
for the Camera properties (Position, Angle, and Distance), as well as for the
background property Fog. Take a moment to think about the movements that
could result from varying each property: zooms and pans, pinwheels, flying
planes, planetary orbits, appearing and disappearing shapes, leaping lizards
emerging from the mist, shifting lights and shadows, exploding text! To get
started, try the following mini-lesson.

Guided Tour: 3D Animation
Follow along with this step-by-step example and create a rotating globe!

Around the world in 20 frames
� Choose ��� from the File menu (choose the “Start from Scratch”

Wizard option) to start with a new, blank scene. If the any planes are
visible, hide them using the Planes toolbar.

� Click the Studio’s ����
� tab and select the “Planets” category. Click
the “Earth” model’s thumbnail and a globe object will appear in the
center of the scene, complete with seas and continents. The African
continent takes up most of the right half of the globe.
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� Show the Animation toolbar (using
 	������
����) if it’s not already visible. Click
the ���� button if necessary to reveal the
extended Edit Panel.

In the upper Frames group, note that the ����
 box is showing there are 20
frames in the sequence (the default value). The !����
� box shows we’re
looking at frame 1, and so the adjacent !����
������� slider is set to its far
left position. Looking at the lower Key Frames group, you’ll see an
assortment of various check boxes with associated sliders and buttons. These
will all be much less mysterious in a moment.

� With the Move/Size tool, deselect the Earth by
clicking in an empty part of the scene window,
and now in the Key Frames group you’ll see that
only the !����� property is enabled. That’s
because Camera Angle and Camera Distance
apply to the scene as a whole, regardless of
what’s selected.

� Now select the Earth object, and all the check
boxes for object-specific properties become
available, as at right.

Let’s create the key frames that will tell the Earth how to rotate. In order to
generate a convincing full-cycle rotation, 3DPlus needs us to provide several
snapshots of what the Earth should look like at key positions in the cycle. So
let’s proceed to define our key frames: a starting and ending view, and a
couple of intermediate views.

� The only property we need to include in the
animation is rotation, so check the �����	�
 box.

� Click the  button at the right of the �����	�
�"�������� slider. A key
frame marker appears at the far left of the slider (frame 1).

� Click about a third of the way along the !����
������� slider, at frame
8. We’ll create a key
frame for the first
intermediate view here.
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� Choose the Rotate tool. Click on the “Y” axis label and drag down to
rotate the Earth until the east coast of South
America is just disappearing over the horizon (on
the HintLine “object angle” readout, a Y value of
about -105º). When you release the button after
dragging, 3DPlus inserts an automatic key frame
marker at frame 8 at on the �����	�
�"��������
slider.

Note that 3DPlus automatically defines a new key frame each time you adjust
one of the object properties included in the animation—that is, a property
you’ve checked in the Key Frames group. (If for any reason you don’t want a
new key frame, just click the  button to delete it.)

� Click on the !����
������� slider again, this time
selecting frame 15. To create the second
intermediate view, drag down on the Y axis until
Australia is centered in the view (Y value of about
130º on the HintLine). A third key frame marker
appears.

� For the end frame of the sequence, the Earth should be rotated nearly all
the way around, just short of its starting position. To get to the end
frame, type “20” into the !����
������� box, or click the far right end
of the !����
������� slider. The scene will still look as it did in frame
15.

� Drag down on the Y axis to continue the Earth’s
rotation. Watch the HintLine and stop rotating when
the Y value is about 10º. A fourth key frame marker
appears at the far right of the �����	�
�"��������
slider.

� Now click the  �
�� button and you’ll see the Earth rotate!

To make it rotate continuously, click the  ���� button.

Congratulations! You’ve just made the Earth move. And now for a shortcut.
Completing the above sequence will give you a valuable first-hand feel for
animating an object from scratch... but in this case there’s an easier way to
get an object to rotate.

� Start with a new globe object, then simply look on the Studio’s Gallery
tab, locate the Spins section of the Animations category, and apply the
“Y Axis Rotated Counter-Clockwise” effect to the globe!
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Editing Animations
If you’ve just completed the mini-lesson above, or have created an animation
using a Wizard (or perhaps one of your own design), the Edit Panel on the
Animation toolbar will show the key frames defined for each object in the
scene. If there’s more than one object, you’ll need to click each one
individually to see its key frames. Note that animations will often include
static objects that don’t move at all during the sequence.

It’s easy to edit animations by adding new objects to the scene (with or
without movement), replacing Wizard text with your own, and so on. Here
are some additional pointers on working with the Animation toolbar:

♦ You can click on any key frame marker to jump to that frame.

♦ For a rapid preview, drag the !����
������� slider.

♦ If a particular object transformation appears jerky, first determine which
property and key frame seem to be the source of the problem. Then go to
that key frame and either:
�  Adjust the object property itself; or
�  Move the key frame marker slightly (e.g. drag it left or right a frame at
a time).
Moving two key frames closer together has the effect of speeding up the
transformation between them; moving them apart slows things down.

♦ To change the overall playback speed, type a new value into the �����
box and press #
���. Bear in mind that playback in 3DPlus may not
match the frame-per-second rate shown in the box. That value, will,
however, be used when the animation is exported. To determine an
optimal rate setting, always preview the exported .GIF file in a browser
or GIF editing program.

♦ To change the sequence length, simply type a new value into the ����

box and press #
��� (but see the following paragraph). Frames are added
or subtracted at the end of the sequence. In general, the final .GIF file
will be more compact if it has fewer frames. There’s nothing fixed about
the default length of 20 frames. Many convincing animations can be
accomplished in 10 frames or less.
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♦ Be careful if adding or subtracting frames after you’ve defined key
frames. Obviously, the resulting sequence won’t have the same number
of frames—and there’s no undo for this action—so decide beforehand
what you want 3DPlus to do with the existing key frames.
� To preserve the current “spread” of key frames between the first and
last frames, keep the $
�����
����"��������� box checked. For
example, if you had a 12-frame sequence with key frames on 1, 6, and
12, and increased the total frames to 20 with interpolation, the resulting
key frames would be on 1, 10, and 20.
� Uncheck the box to leave existing key frames exactly where they are.
With no interpolation, the key frames in our 12-to-20-frame example
would remain at 1, 6, and 12. This would be useful if you planned to add
more motion to the end of the existing sequence. Note that if you
subtract frames with no interpolation, key frames at the end of your
sequence may be deleted.

♦ When working with animated presets from the Studio, don’t expect them
to work immediately in a static scene; click the �
�� button first. If
you’ve applied a preset but don’t see any properties checked on the
Animation toolbar, it’s because the key frames have been set for specific
objects—so you’ll first need to select those object(s). For example,
certain text effects involve individual character objects within words. Or,
in the case of animated lighting schemes, first click the Lights tab and
then select individual lights. Once you’ve selected an object, you can see
which key frame properties have been set for it.

♦ The easiest way to remove animation from an object is simply to select
the object, then uncheck all the property boxes on the Animation toolbar.
Of course, if you’ve just applied the effect, you can simply use Undo.
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Aside from printing a scene out directly, there are two basic ways of
incorporating a 3DPlus image in a publication or other graphic context:
exporting and OLE.

Exporting
Exporting means converting a 3DPlus scene to an external file format, as
opposed to saving it in the native .3DP format.

When you export, the entire scene window gets converted to an anti-aliased
bitmap graphic. You can fine-tune the graphic in a paint editing program
(like Serif PhotoPlus), so you don’t have to worry if there’s extra background
showing around the scene objects. You can crop the image later. But make
sure you’re satisfied with the composition, lighting, and colors in the scene
before you export—it’s much more difficult to change those later.

Remember that the scene will be exported at its actual size, as specified in the
File/Scene Setup dialog. If you're using a separate paint program, you can
always downsize the image later on.

When you’re done you can import your 3DPlus effect as a graphic, into your
favorite DTP, word-processor or any other application you choose.

Tip: To preview how the scene will appear when anti-aliasing is applied,
click the �����������	�
 button on the Standard toolbar.

For additional details on export options, see the How To topic “Exporting” in
online help.

To export a static scene, choose ��
������ from the File menu. Use the Save
as Type pull-down menu to specify the export file format. Provide a file
name and folder location, and click ����.

To export an animation, choose ��
������	���	����� from the File menu and
provide a file name and folder location. To export as a sequence of stills,
choose ��
������	���	�����	������.

Export settings
In the Export dialog, set any options available for the particular image and
file format. The appearance of the dialog changes somewhat depending on
the format. One standard feature is the Image Preview window, which
provides an accurate rendering of how your scene will look using the current
combination of settings. You can zoom in and out, drag the scene to center it
in the window, and experiment with different export options until the results
are satisfactory.
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♦ Bit Depth: Bit depth relates to the number of colors in the exported
image. For example, a bit depth of 4 bits per pixel can store 16 values; 8
bits per pixel, 256, and so on. 16-bit images have roughly “thousands” of
values to describe each pixel’s color, and 24-bit images have “millions.”
Of course, images with higher bit depth take up more disk space. Choose
the bit depth that corresponds to the number of colors in the exported
image. For 256-color images, you have the option of applying either an
Optimized or a Web-safe palette..

♦ Palette: A color palette is a table of color values that gets stored with
any image having 8 bits (256 colors) or less. If you’re exporting at 8 bits
(256 colors) or less:
� The default �
�	�	��� setting lets the 3DPlus export filter determine
the best colors to apply. This generally results in smooth color gradations
and quite acceptable appearance when viewed on a High Color (16-bit)
or better color display.
� Choose �������� to reduce the colors to only those found in the 216-
color palette used by Web browsers on limited-color systems. This will
ensure that an image you place on a Web page won’t change its
appearance when viewed on such systems.

♦ Dithering: Dithering comes into play with images being reduced to 8
bits (256 colors) or less. It’s a method of approximating colors outside
the actual image palette—for example, by alternating pixels of red and
blue from within the palette to produce the visual impression of a purple
color that's not in the palette. While dithering can degrade solid-color
areas, with 3D images it’s usually more important to preserve subtle
gradations of color.
� To preserve gradations of color and/or an image background, dithering
is clearly the best choice. You can choose either Ordered or Error
Diffusion dithering. The former produces a discernibly patterned effect,
while the latter tends to average away the patterns for a more natural
result.
� To minimize file size, or if you happen to have an image with few
colors, you can opt for no dithering—and the export filter will pick
“nearest-match” color values from the palette being applied. You may
see some color shifting, but the solid color areas will be preserved.
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♦ GIF Options: .GIF files support transparency—one reason they’re
commonly used over backgrounds on Web pages. If your scene uses a
solid color background, 3DPlus gives you the option of exporting as
.GIF with transparency—so the background color goes clear and “drops
out.” In this mode you can either turn anti-aliasing off for a sharper edge,
or leave it on, in which case you’ll get bits of the background color
around the edges of objects in the scene.
Tip: For a GIF that blends smoothly with the color of a Web page,
match your 3DPlus scene’s background color to that of the Web page,
and export as transparent with anti-aliasing on.

♦ Compression: Compression schemes, which apply different algorithms
to encode the image information with fewer total bits and bytes, are used
in many formats. Depending on the format, 3DPlus may include a choice
of compression scheme. In general, use the default setting unless you
know for a fact that some other scheme is called for.
With the .JPG format, recommended for photographic backgrounds, you
can set the level of quality desired using a slider. As you might expect,
the highest-quality setting uses least compression, with no loss of image
quality but the largest file size. The lowest-quality setting applies
maximum compression for smallest size, but yields rather poor quality.

The .PNG Format
For Web graphics, the increasingly popular .PNG (Portable Network
Graphics, pronounced “ping”) format has a number of advantages over
.GIF—the main ones, from an artist’s perspective, being “lossless” 24-bit
images and support for variable transparency. Whereas .GIF supports simple
binary (“on-off”) transparency, .PNG allows up to 254 levels of partial
transparency for normal images. The image file includes an “alpha channel”
that directs pixels in the foreground image to merge with those in a
background image. Most commonly used with 24-bit images, anti-aliasing
creates the illusion of smooth curves by varying pixel colors—for rounded
images that look good against any background, not just against a white
background. It’s especially useful for the small graphics commonly used on
Web pages, such as bullets and fancy text.



60    Using 3DPlus with Other Software

Animation formats
The .GIF format is what makes Web animation possible, for a couple of
reasons. First, it’s universally supported by Web browsers. Second, it’s a
multi-part format, capable of encoding not just one image but multiple
images in the same file. A .GIF animation player or Web browser can display
these images in sequence, in accordance with certain settings (looping, frame
delay, etc.) included in the file. The result—it moves!

The .AVI (Audio-Video Interleaved) format is commonly used on the
Windows platform to encode image sequences in sync with a mono or stereo
sound track. 3DPlus can export to the uncompressed .AVI format using 24-
bit color, or to various compressed formats, depending on which codecs
(compression/decompression schemes) are present on your machine. 3DPlus
doesn’t ship with specific codecs; however, several are shipped with
Windows itself, and you can easily obtain others on the Web. (Check the
codec’s documentation for correct bit depth settings; 8-bit is the standard.)
Note that .AVIs don’t support certain playback properties of the animated
.GIF format, such as “Loop” and “Ping Pong.”

OLE (Object Linking and Embedding)
Exporting 3DPlus files as bitmap graphics is appropriate when you’re
working with an application that requires images in a specific format (such as
.JPG or .GIF for a Web page editor), or if you need to edit the graphic using a
paint program. The drawback of exporting is that you lose the ability to edit
the scene itself in 3DPlus.

Many applications—for example, Serif’s desktop publishing program
PagePlus—allow you to insert a 3DPlus scene as an OLE object. This means
you can still use 3DPlus to modify the scene later, if necessary. For example,
you can change the text in a text object or alter the color scheme without
having to start from scratch.

In some situations, exporting (as described earlier) may be your only choice.
For example, if your graphic requires a transparent background, you’ll need
to export to the .GIF format. Also, you may find that OLE can be slow and
cumbersome due to the amount of bitmap data required for displaying and
printing 3DPlus objects at suitable quality.

Following are general guidelines for working with 3DPlus OLE objects in a
client application. (Bear in mind that actual procedures may differ depending
on the application and operating system version.)
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 Choose the application’s ���������������� command, usually found on its
Edit menu, and select “Serif 3DPlus 3.0” from the list of object types. Then,
to insert a saved 3DPlus (.3DD) file, choose the  �����������!	�� option and
locate the file name. Check the "	�# box to link the object or leave the box
unchecked to embed the object (so it’s independent of the original file). Or,
to create a new 3DPlus object, choose the  ������$�
 option. 3DPlus opens
with the Startup Wizard (or a blank scene window if the Wizard is turned
off). When you’ve created the scene, choose %
���� from the File menu to
insert the scene as an object (or update the image already there) without
closing 3DPlus.

To edit a 3DPlus object in any application, double-click the 3DPlus OLE
object within the application, or select the object and choose the application’s
��	�������� command. In Serif PagePlus, either action will launch 3DPlus,
displaying the scene ready for editing.

When you use OLE to create a 3DPlus object in a client application such as
Serif PagePlus or Microsoft Word, the object’s resolution—its quality when
viewed or printed from the client application—depends on the ratio of its
dimensions in 3DPlus to its dimensions in the application. For example,
suppose you have set the dimensions of a 3DPlus object to 300x300 pixels
using the Scene Setup dialog. If the object occupies a 2-inch (5cm) square on
the client application’s page, its resolution will be 150 pixels to the inch (300
divided by 2). If you resize the object to a 1-inch square in the client
application, its resolution will increase to 300 pixels to the inch. Conversely,
if you increase the object's size, its resolution will decrease.

For additional details on using OLE, see the How To topic “Linking and
embedding” in online help.


